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The action bar is a toolbar containing icons and links for important actions like , , Search New Records Delete 
, or . Action bars appear above table views, including related tables in Records Mass Edit Records other records.

Example action bar

You can configure multiple action bars for one table for use in different contexts or by different users. , For example
you may want to show custom actions to one team of users but not others. A team of contract creators, for instance, 
may see a Convert button that converts a selected contract to a related contract. However, a team of  contract
reviewers may not see the button because their role doesn't require them to create new contracts.

More commonly, you'll use different action bars when viewing a table directly as opposed to viewing a related table 
shown in another record. For instance, if you're viewing a related table of contracts within a company record, you 
might want a different action bar with a custom action that creates a new contract record with company information 
already included.

Action bars are created and edited in the Table wizard, which is typically accessed by clicking Setup [ ] Table Name
on the left pane. Every table has a default action bar that cannot be deleted. The default action bar is automatically 
shown to users who don't have another action bar assigned.

To edit the default action bar for a table:

In the Table wizard, click the Action Bar tab.

Edit the action bar called Default.

In the Action Bar wizard, click the Design tab.

Action Bars

Useful to Know

You can create and customize action bars by adding or removing menu items, changing labels and 

icons, or creating multiple rows.

Action bars are applied to   of users. You can have different action bars shown to different sets Teams

of users. The user's Primary Team determines which action bar they see.

Some items, like Export, are controlled by . For instance, if a user doesn't have group permissions

permission to export records, the export icon is hidden. Similarly, if they do not have permission to 

print records, the print icon is hidden.

You can place custom actions in the action bar.

Many actions, including custom actions, can run on multiple records at once.

Change the Default Action Bar
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Make your desired changes in the editor.

Click Finish to save changes.

The wizard for Default action bars does not include the Apply tab. For all other action bars, you must choose which 
.teams use the action bar

In the Action Bar wizard, the Design tab shows available menu items on the left and the action bar's arrangement in 
the right pane. Drag and drop items on the right to arrange them how you like. The tab has several buttons in the 
center for customizing the action bar:

Remove: Removes an action, separator, or row  from the right pane, which removes it from action separator

bar.

Add: Adds an action to the right pane, which adds it to the action . The Type of Action drop-down bar

contains two lists of actions: System Menu Items and Action Button Items. System Menu Items are generic 

actions available on any table, while  Items are actions associated with action buttons on the Action Button

current table.

Edit: Edits an action on the right pane and lets you change the action's text, icon, and display mode. You can 

choose from the available icons or upload your own.

Separator: Adds a separator to  right pane, which adds it to the action bar. You can drag and place the the

separator among the actions to create space between sections of the action bar.

Row Separator: Adds a row separator to the right pane, which creates a new row on the action bar. You can 

drag and place the row separator as desired.

New Menu Item: Opens a pop-up window for creating a group, into which you can place actions. Groups 

appear on the action bar as drop-down menus containing actions. You can change the group's text, icon, and 

display mode.

Design an Action Bar Layout

Best Practice Tips

If you're   an Action Button Item to an action bar, we recommend using the following settings when adding
configuring the action button:

In the "After executing actions" section, it's usually best to select one of these options: Do Nothing, 

Close Record without Saving, or Save Record. Think carefully before selecting the Save and Open 

Record for Edit or the Save and Open Record for View options. When executing actions from a table 

view, users do not typically want to open the record afterwards.

Do not add a Validate action with the option selected that allows the user to ignore the warning and 

save the record. The system will not prompt the user with the option to ignore the warning, and any 

actions after the Validate action will not execute.
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The Apply tab of the Action Bar wizard is where you decide which teams should use the action bar as their default 
for the current table.

If no teams use the action bar, it doesn't appear anywhere in the system unless it is explicitly used in a related table 
or linked field. You don't need to apply an action bar to a team for the action bar to appear with a related table or 
linked field.

To apply an action bar to selected teams:

In the Apply tab, select Change settings, and then select the "Action Bar is the default for teams" checkbox.

Choose one or several teams. Use Ctrl to select multiple teams.

Optionally, choose whether subteams of the selected teams, and any new teams, will use this action bar.

Click Finish to save the changes.

Several  are shown within records as embedded tables, in particular the Related Table, Link to Selected Data Types
Fields with Multiple Values , and Embedded Search Result data types. Each of these can be shown Enabled (MVE)
with a specific action bar, the user's default action bar, or no action bar. Additionally, you can choose whether the 
full action bar is shown in the record in view and edit mode, or edit mode only.

Apply Action Bars to Teams

Apply Action Bars to Linked Fields and 
Related Tables

https://wiki.agiloft.com/display/HELP/List+of+Data+Types


The action bar settings appear on the Display tab of the field wizards for related tables, links to selected fields with 
MVE, and embedded search results. You can select an existing action bar from the drop-down menu, choose to 
display the user's default action bar for the source table, or choose not to show an action bar at all.

The best practices differ between data types. For embedded search results, it's usually best not to show an action 
bar at all, since these fields are designed to show a list of records calculated by the system without any interaction 
from the user.

Both related tables and links to selected fields with MVE tend to work best with limited action bars that reduce the 
number of options. For these, Delete, Export, Import, and Copy are commonly excluded. Delete, for example, can 
be misleading in embedded tables, where users might expect Delete to refer to deleting the link between records, 
rather than deleting the record itself. Related table action bars typically also choose the option to "Allow all actions 
in Action Bar only when editing the main record," to make sure options like Unlink or New function as expected. In 
cases where the field holds only a few records that are shown at all times, it's typically unnecessary to include the 
Search option.

Example

For example, consider the Default action bar on the People table:

Action bar in People table

Compare it to the focused Related Table Action Bar used for People table data in the Companies table:

Action bar in related table



This table summarizes the actions available in action bars, as well as which group permissions and system settings 
control those actions. Depending on a group's permission setting, an action may or may not be available on an 
action bar for a specific user. For example, if none of a user’s groups is allowed to create records in a table, they 

New Print don't see the  button. If they are not allowed to print records, they don't see the    icon. If the Actions drop-
down menu only includes Import and Export, but a user isn't allowed to use either option, they don't see the Actions 

. For more information on group permissions, see .drop-down menu at all Creating New Groups

Action Description Permission and System Controls

New Creates a new record in the table. Permission to create records.

Edit Edits the selected record(s). Permission to edit records. This menu item 
only appears in related tables and multi-
value linked fields.

Copy Copies the selected . See record(s) Copying Records
.

Permission to copy records.

Delete Deletes the selected s). This removes the record(
records from the database, and it cannot be undone 
except by restoring the knowledgebase from a 
backup file. See .Deleting Records

Permission to delete records.

Search The Search menu lets users switch between 
available published searches. Clicking the link 
opens the search block for ad hoc searching. 
Additionally, the Search menu includes options to 
create, edit, and manage saved searches. See 

.Using Saved Searches to Work Efficiently

Search is visible to all users. The New, Edit, 
and Manage menus in the Search drop-down
are enabled by the permission to create/edit 
saved searches.

Views The View menu lets users switch between available 
published table views and to create, edit, and 
manage views. See .Views

Visible to all users. The New, Edit, and 
 menus in the Search drop-down are Manage

enabled by the permission to create/edit 
views.

Click to 
search 
records

This item appears as a magnifying glass icon. It 
only appears in action bars displayed above related 
tables and linked fields with . It is multiple values
used to search for a record and link it to the current 
record in the multi-value enabled field.

Visible with related tables and multi-value 
linked fields. Requires that the setting "Allow 

 is selected in the users to unlink records"
Field wizard.

Convert The Convert action runs all conversions defined in 
the table on the selected record. It is more common 
to create an action button that runs a specific 
conversion action and add that to the action bar, 
rather than show the default Convert button.

Requires that the "Show conversion button 
on menu action bar" permission is selected. 
It also requires that conversion mappings 
have been defined for the table.

Action Bar Menus, Permissions, and 
Controls
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Export / 
Import

Import can create new records or update existing 
records with new data. Export is used to create a 
file that includes data from the selected records.

Permission to export or import records, 
respectively. Each permission is set 
independently.

Unlink Removes a record from a multi-value linked field set. This item only appears in action bars applied 
to linked fields with multiple values enabled. 
It is used to remove a record from the list in 
the linked field.

Mass 
Edit

Edit multiple records at once using a dialog that 
offers plain text or formula-based updates. See 

.Mass Editing Records

Permission to mass edit records.

New 
Email

Open the new email dialog and manage email 
templates. See .Implementing Outbound Email

Access to the Emails subtable in the 
Communications table, as well as 
permission to create emails. Additional 
options are enabled by the permission to 
create/edit, manage, and send email 
templates.

New 
SMS

Open the new SMS/text message dialog. Permission to use SMS templates, or to 
create/edit SMS templates.

Print 
Records

Print selected records. See Printing a Set of 
.Records

Permission to print records using the Print 
icon. Additional options are enabled by the 
permission to create/edit print templates and 
the permission to use print templates. Note 
that "Print files to zip" is controlled by export 
permissions as well.

Add Note Create a Note linked to the selected record or 
records. This action is disabled by default in most 
systems.

Permission to create Notes in the 
Communications table.

Custom 
Actions

Any action button field can be added to the action 
bar.

Requires that the user has permission to 
view the action button in the table. Note that 
visibility or edit dependencies are not 
enforced when action buttons are added to 
the action bar.

Save 
Changes 
/ Cancel 
Changes

These items appear when looking at a   Quick Edit
view. Save multiple changes at once, or cancel all 
changes in the current table view.

Users must have permission to use quick 
edit views, and be using a view with Quick 
Edit enabled.
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